REN ESAS Application Note

RZ/V2L, RZ/V2H
Getting Started with Flexible Software Package

Introduction

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing applications for
the RZ microprocessor series.

Target Device
RZ/V2L, RZV2H
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1. Introduction

1.1 Overview

This application note describes how to use the Renesas Flexible Software Package (FSP) running on the
Cortex®-M33 (hereinafter referred to as CM33) and Cortex®-R8(*)(hereinafter referred to as CR8)
incorporated on RZ/V2L, and RZ/V2H.

(*: CR8 is for RZ/V2H only.)

1.2 Introduction to FSP

1.2.1 Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy
to use, scalable, high-quality software for embedded system design. The primary goal is to provide
lightweight, efficient drivers that meet common use cases in embedded systems.

1.2.2 e? studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ series of
MPU devices. The e? studio IDE provides a familiar development cockpit from which the key steps of project
creation, module selection and configuration, code development, code generation, and debugging are all
managed.

1.3 Limitations

1.3.1 Peripherals and pins assignment

RZ/V2L has a multi-core configuration of Cortex-A55 (hereinafter referred to as CA55) and CM33. Also,
RZ/NVV2H has a multi-core configuration of CA55, CM33 and CR8. It is possible to use each peripheral and
GPIO from each core. This package provides drivers for each peripheral for CM33 and CR8, but each driver
can operate on the assumption that it is not used in CA55.

1.3.2 RAM Initialization

Initialization of DDR SDRAM is always carried out in CA55 bootstrap regardless of the selection of boot
CPU, meanwhile Internal SRAM is initialized in the bootstrap of boot CPU.
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2. Starting Development Introduction

21 e?studio setup

2.1.1 What is e? studio?

Renesas e? studio is a development tool encompassing code development, build, and debug. e€? studio is
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing for RZ MPUs, e? studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management of
modules and threads, to easily implement complex applications.

21.2 e?studio Prerequisites
2.1.2.1 Obtaining an RZ MPU Kit
To develop applications with RZ/V FSP, start with each Evaluation Board Kit.

Start-up guide of RZ/V2L Evaluation Board Kit is available at RZ/V2L SMARC EVK Start-up Guide.
Also, Getting Started of RZ/V2H Evaluation Board Kit is available at RZ/V2H EVK Getting Started.

2.1.2.2 PC Requirements
The following are the minimum PC requirements to use e? studio:

¢ Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e Minimum 250-GB hard disk

2.1.2.3 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.1.3 e? studio installation for Windows PC
This chapter describes how to install the e? studio IDE on Windows PC.

2.1.3.1 Download

The latest e? studio IDE installer package can be downloaded from Renesas website for free. Please check
detailed information from: https://www.renesas.com/e2studio. Note that user has to login to the Renesas
account (in MyRenesas page) for the software download.

RO1AN6240EJ0202 Rev.2.02 Page 5 of 62
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2.1.3.2 Installation of e? studio IDE

1. Double-click on e? studio installer to invoke the e? studio installation wizard page. First, you need to select
Install Type. In this material, it is expected that Custom Install is selected. Then, click [Next >] to continue.

Note: If e? studio was installed in your PC, the option to modify, remove the existing version or install
e? studio to a different location will be displayed

EA Renesas &? studio 2024-07 Setup (] X
Renesas e’ studio 2024-07 Setup
RENESAS

Install Type

Please select the & studio installation type. Click here for help selecting a type and to see what features are included.

Select Install Type:

—_ Lite Install (Recommended)

;,‘ This installs €* studio in Lite Mode.

~ This mode offers a simplified experience focused on simple code editing & debugging with only important features
—_ Standard Install

;,' This installs €* studio in Advanced Mode.

___This mode offers all extended debugging functionality and other advanced features

Custom Install

e Custom installation of &* studio
This mode is allows you to select which features are installed

e Cancel

2. Welcome page

Figure 1: e? studio installation wizard

User can change the install folder by clicking [Change...].Click [Next] to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.

Note2: Multi-byte characters cannot be used for e? studio installation folder name.

& Renesas e studio 2024-07 Setup [m] X

Renesas e studio 2024-07 Setup RE N E SAS

() Welcome Install directory ready =
v Install Location:
° Prerequisite software already installed

Internet connection available

Change Proxy Settings...

Ready to install
Software to install:
+ Renesas e2 studio v24.7.0.R20240620-1807

+ Java Runtime v17.0.0

« AR Plugin Manager v1.1.0.202007251457

« Renesas e2 studio Common Components (Lite) v24.7.0.R20240620-1807
« Renesas e2 studio Common Components (Full) v24.7.0.R20240620-1807
+ Renesas QE Common Components v24.7.0.R20240620-1807

+ Eclipse CDT Linker Script Editor and DSL v1.0.112.v20240408-2044

= lardl AdAnbismm MNnanilW Untrnnt IDE Camnbaba 017 0 100IN0ANTIN 1143

Back Instal Cancel

Figure 2: Installation of e? studio — Welcome page
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3. Device Families
Select Devices Families to install. Click the [Next] button to continue.

A Renesas e? studio 2024-07 Setup O X

Renesas e’ studio 2024-07 Setup ;EN ESAS

Select the device families you wish to install support for

Welcome O A% RA A
. L RA Build, Debug & Code Generation support for Renesas RA devices
Device Families
AW RZ
RZ i —
Build, Debug & Code Generation support for Renesas RZ devices
0 A RL78
rRL78 Build, Debug & Code Generation support for Renesas RL78 devices
AW RX
DlRx

Build, Debug & Code Generation support for Renesas RX devices

0 EETTy
RHB850 Debug support for Renesas RH850 devices

. RE
O RE i —
Build & Debug support for Renesas RE devices

Synergy

[JRENESAS
Build, Debug & Code Generation support for Renesas Synergy devices
& _ 1 1 na v
Select All

< Back Insta Cancel

Figure 3: Installation of e? studio — Device Families

4. Extra Features
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For
non-English language users, please select Language packs at this step if needed.
Click the [Next] button to continue.

24 Renesas e studio 2024-07 Setup o b 4
Renesas e? studio 2024-07 Setup
LENESAS
Select the extra features you wish to instal
Welcome O Japanese Language Support
[ -
Device Families

@ ExRFoaties =) Chinese (Simplified) Language Suppart

Chinese (Traditional) Language Support

]
Git Integration
O -
Git SCM Support
O Terminals
et ANSI/V102 compatible Terminal support for Serial, ssh and Telnet
Select All

< Back nstal Cancel

Figure 4: Installation of e? studio — Extra Features
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5. Customize Features

Select the components to install and click the [Next] button to continue. Be sure that Renesas FSP Smart
Configurator Core and Renesas FSP Smart Configurator ARM are selected.

EA Renesas e* studio 2024-07 Setup a X

Renesas e” studio 2024-07 Setup :{E N ES AS

Welcome Select the components you want to install.
Device Families ;

(O Renesas Synergy Family Support (24.7.0.R20240620-1807)
Extra Features

s % [[JRenesas DA Family Support (24.7.0.R20240620-1807)

Features Renesas FSP Smart Configurator Core (9.6.0.v20240619-0945)

Renesas FSP Smart Configurator ARM (9.6.0.v20240619-1422)

(O Renesas RISC-V MCU Support (24.7.0.R20240620-1807)
Renesas QE Common Components (24.7.0.R20240620-1807)
(D Git integration for Eclipse (6.9.0.202403050737-r)

£ () Additional Tools (24.7.0.R20240620-1807)

Select All Optional | Deselect All Optional

Size of install: 911.5 MB

< Back Insta Cancel

Figure 5: Installation of e? studio — Features

6. Additional Software

Select additional software (i.e., compilers, utilities, QE...) to be installed. Be sure to select the following
item and click [Next] to continue.

GNU ARM Embedded 12.2-Rel1

A Renesas e? studio 2024-07 Setup [m} X

Renesas e? studio 2024-07 Setup ;{E N E SAS

Select the additional software you wish to install

Welcome [[] Renesas QE
Device Families [J Renesas Al
v [] Renesas Toolchains && Utilities
Extra Features [] Renesas E2 Self-Checking Pragram V1,02.00 v1.02.00 10008
Customise |:| Renesas E2 Lite Self-Checking Program V1.00.00 v1.00.00 1000 B
Features [] Renesas E1, E20 Self-Checking Program V1.01.00 v1.01.00 1000 B
- v [W] GCC Toolchains && Utilities
Additional [ 7 oNU ARM Embeaded 122-Relt 1221arm-12-24 10008 |
Software [T GNU ARM Embedded 10.3 2021.10 1030202110 1000 B
[[] GNU ARM Embedded 9.3.1 2020q2 9.3.1.2020q92 1000 B
[[] GNU ARM Embedded 9.2.1 2019g4 9.2.1.2019q4 1000 B
[[] GNU ARM Embedded 6 2017q2 6.0.02017q2 1000 B

GCC ARM A-Profile (AArch64 bare-metal) 13.2.Rell 13.2.1.20231009 1000 B

[[] GCC ARM A-Profile (AArch64 bare-metal) 10.3 2021.07 10.3.0.2021-07 1000 B

[[] LibGen for GNU ARM Embedded 1.2023.11 88MB
[[] Renesas FSP

381.5 MB download required

< Back Insta Cancel

Figure 6: Installation of e? studio — Additional Software

For more details on the installation of Additional Software, please see the section 2.1.3.3.
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7. License Agreement

Read and accept the software license agreement. Click the [Next] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.

Welcome

Extra Features

Customise
Features

Additional
Software

@ Licenses

Device Families

& Renesas e? studio 2024-07 Setup

Renesas e’ studio 2024-07 Setup

Please read and accept the following Software Agreements

Renesas e2 studio

OpenlDK License Agreement
ARM DS-5 Toolchain Integrat

IAR Plugin Manager

m] X

RENESAS

License Terms and Conditions for RENESAS e2 studio A

This Renesas e2 studio license agreement ("Agreement”) is between the
entity on whose behalf you are entering into this Agreement ("Client”) and
Renesas Electronics Corporation, a Japanese company with its registered
office at 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan ("Renesas”). YOU
SHOULD READ THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A
BINDING CONTRACT BETWEEN CLIENT AND RENESAS.

The Renesas IDE Software (defined below) is intended for commercial use
by a company or corporation only and is not designed, developed or
produced for any private use or purpose. If you are an individual, or you
intend to install the Renesas IDE Software on behalf of an individual, or the
Renesas IDE Software is expected to be used for a private purpose directly
or indirectly, you should click "No” on the installer.

Otherwise, by clicking the "I accept” button or ather button or mechanism
designed to acknowledge agreement to the terms of an electronic copy of
this Agreement, or by installing, accessing, or otherwise copying or using all
or any portion of the Renesas IDE Software, you accept this Agreement on
behalf of the entity for which you are authorized to act (e.g., an employer)

& > | land acknowledae that such entitv is leaallv bound bv this Aareementand
I [11l accept the terms of the Software Agreements I Print all..
<Back [ Insta Cancel

8. Shortcuts

Figure 7: Installation of e? studio — Licenses

Select shortcut name for start menu and click [Next] button to continue.

Note: If e? studio was installed in another location, it is recommended to rename to distinguish from the

other e? studio(s).

Welcome

Customise
Features

Additional
Software

Licenses

Device Families

Extra Features

A Renesas e studio 2024-07 Setup

Renesas e’ studio 2024-07 Setup

Shortcuts to important programs and files will be created in the following locations:

In start menu group: |Renesas Electronics e2 studio

] X

RENESAS

£ Restore Default

@ Shortcuts

Cancel

< Back

Figure 8: Installation of e? studio — Shortcuts
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9. Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to
install the Renesas e?studio IDE.

A Renesas e studio 2024-07 Setup ] X
Renesas e’ studio 2024-07 Setup
ENESAS
-
Welcome Ready to install
Device Families Software to install:
Extra Features * Renesas e2 studio v24.7.0.R20240620-1807
« Java Runtime v17.0.0
Customise « IAR Plugin Manager v1.1.0.202007251457
Features « Renesas e2 studio Common Components (Lite) v24.7.0.R20240620-1807

* Renesas e2 studio Common Components (Full) v24.7.0.R20240620-1807

* Renesas e2 studio Common Components for ARM Devices v24.7.0.R20240620-1807
* Renesas e2 studio Tools v24.7.0.R20240620-1807

Licenses * Renesas RZ Family Support v24.7.0.R20240620-1807

+ Renesas RZ Family Support (requiring .Net Framework) v24.7.0.R20240620-1807

Additional
Software

Shortcuts + Renesas FSP Smart Configurator Core v9.6.0v20240619-0045
Drivers + Renesas FSP Smart Configurator ARM v9.6.0.v20240619-1422
+ Renesas QE Common Components v24.7.0.R20240620-1807

@ Summary + ARM DS-5 Toclchain Integration v1.0.5.v20240408-1026

« Eclipse CDT Linker Script Editor and DSL v1.0.112.v20240408-2044

* GCC for Renesas RZ Build Support v24.7.0.v20240613-0901

« GCC for Renesas RZ Support Files v24.7.0.v20240513-0255

« Just) Adoptium OpenJDK Hotspot JRE Complete v17.0.10.v20240120-1143

« Renesas Build Support Files v9.6.0.v20240408-1639

* Renesas CMake Build Support Files v9.6.0.v20240408-1639

« Renesas Common Project Import/Export v9.6.0.v20240606-0906

+ Renesas Debug Views v9.6.0.v20240607-0813 hd

:ﬁackﬁ | Next > Install Cancel

Figure 9: Installation of e? studio — Summary

10.Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. Please see chapter 2.1.3.3 for more detailed information.

11.Results
Click the OK button to complete the installation.

2 Renesas * studio 2024-07 Setup u} X
Renesas e’ studio 2024-07 Setup
LENESAS
Weleorme Installation of e2 studio is complete.

Earefan. = Please click OK to close
Extra Features

Customise [Jraunch e2 studio?
Features View Release Notes?
Additional [/ view What's New?
Software

Licenses
Shortcuts
Drivers
Summary

Installing...

@ Results

Figure 10: Summary Page

RO1AN6240EJ0202 Rev.2.02 Page 10 of 62
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2.1.3.3 Installation of Additional Software

As mentioned in the section 2.1.3.2, the additional software listed below is essential for RZ/V FSP.

GNU ARM Embedded 12.2-Rel1.

In this section, the detailed procedure for installing this tool.

¢ GNU ARM Embedded Toolchain 12.2-Rel1

If it was selected in the Additional Software pane of €? studio, you will see the installation wizard for the
GNU ARM Embedded Toolchain during the installation process.

{37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf = X

Welcome to Arm GNU Toolchain
12 2 rell aarch64-none—elf Setup

Setup will guide you through the installation of Arm GNU
Toolchain 12.2.rel1 aarch64-none-elf.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

{57 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf — X

S

License Agreement

Please review the license terms before installing Arm GNU Toolchain 12.2.rel1
aarché4-none-elf.

Press Page Down to see the rest of the agreement.

anu,org/software binutils/), A

adb/) under the following |ICEDSE(;).

Contains code from project GNU Binutils (b
GNU Debugger (httos://: qnu.org/sc

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf orc
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

If you accept the terms of the agreement, dick I Agree to continue. You must accept the

| agreement to install Arm GNU Toolchain 12.2.rel1 aarché4-none-elf.

Cancel

(37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf —

Choose Install Location
Choose the folder in which to install Arm GNU Toolchain 12.2.rel1 aarch64-none-elf.

&

Setup will install Arm GNU Toolchain 12.2.rel1 aarché4-none-elf in the following folder. To
installin a different folder, dick Browse and select another folder. Click Install to start the
installation.

Destination Folder

bram Fies (:86)¥Arm GNU Toolchain aarché4-none-¢lf¥ 12.2 rel 1]

Browse...

Space required: 719.3 MB
Space available: 20.7 GB

3
|

<Back | Cancel

(37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf —

Completing Arm GNU Toolchain
12 2 rell aarch64-none-elf Setup

Arm GNU Toolchain 12.2.rel1 aarch64-none-elf has been
installed on your computer.

Click Finish to dlose Setup. 4

[C]show Readme

[JLaunch geevar bat

Add path to environment variablei
(] Add registry information

Figure 11: Installation of GNU ARM Embedded Toolchain
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2.1.4 e?studio installation for Linux PC
This chapter describes how to install the e? studio IDE on Linux PC.

2.1.4.1 Download

The following files are required to download before installation.

SEGGER J-Link driver
Please download the driver V7.96e or later from:
https://www.segger.com/downloads/jlink/JLink_Linux V796e x86 64.deb

e? studio IDE installer
e? studio IDE installer package can be downloaded from Renesas website for free. Please check detailed
information from: https://www.renesas.com/e2studio.

2.1.4.2 Installation

This section describes the procedure of each software installation.

Filename, version number and the file path is provided for example purpose only.

SEGGER J-Link driver
1. Open a terminal window and enter below commands.
sudo dpkg -i JLink_Linux_V796e_x86_64.deb

(If the previous install fails with unmet dependencies, retry it as follows)
sudo apt-get -f install
sudo dpkg -i JLink_Linux_V796e_x86_64.deb

e? studio IDE

1. Run the e? studio IDE Installer. (Before running the installer, check the execution permission of the
installer.)
Je2studio_installer-2024-07_linux_host.run

2. Welcome page
User needs to select Install Type as shown below. In this material, it is expected that Custom Install is
selected. Then, click [Next >] to continue.

[} Renesas e? studio 2024-07 Setup [=1[E3

RENESAS

Renesas ¢? studio 2024-07 Setup

install Type
Please select the e studio installation type. Click hers for help selecting 3 type and to see what features are included
Select Install Type:

Lite Install (Recommended)
lls & stud

ence focused on si

Figure 14: Installation of e? studio — Welcome page
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3. Welcome page (Cont’d)
User can change the install folder by clicking [Change...].
Click [Next] to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.
Note2: Multi-byte characters cannot be used for e? studio installation folder name.

0 Renesas e* studio 2024-07 Setup =13

RENESAS

Renesas e? studio 2024-07 Setup

@Wel(ome Install directory ready

Install Location:

° already i

Internet connection available

Change Proxy Settings...

Ready to install

Software to install:
* Renesas e2 studio v24.7.0.R20240620-1807
* Java Runtime v17.0.0
* IAR Plugin Manager v1.1.0.202007251457
» Renesas e2 studio Common Companents (Lite) v24.7.0.R20240620-1807
* Renesas @2 studio Common Components (Full) v24.7.0.R20240620-1807
* Renesas QE Common Components v24.7.0.R20240620-1807
» Eclipse CDT Linker Script Editor and DSL v1.0.112.v20240408-2044
= Just) Adoptium OpenjDK Hotspot JRE Complete v17.0.10.v20240120-1143
* Renesas Build Support Files v0.6.0.v20240408-1639
* Renesas CMake Build Support Files v9.6.0.v20240408-1639
* Renesas Common Project Import/Export v9.6.0.v20240606-0906

—1
o

Figure 15: Installation of e? studio — Welcome page
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4. Device Families
Select Devices Families to install. Click the [Next] button to continue.

0a Renesas e* studio 2024-07 Setup O] x

Renesas e? studio 2024-07 Setup

Select the device families you wish to install support for n z E N ESAS

Welcome A RA
@ Deavice Farilies RA Build, Debug & Code Generation support for Renesas RA devices
AW RZ
o Rz Build, Debug & Code Generation support for Renesas RZ devices

ST
RU78 Build, Debug & Code Generation support for Renesas RL78 devices

RX
( RX Build, Debug & Code Generation support for Renesas RX devices

AW, RH850

RHB850 Debug support for Renesas RH850 devices

\RE

ReE Build & Debug support for Renesas RE devices

AW Linux on Renesas RZ

RZ Build & Debug support for Linux on Renesas RZ devices
1 DA
&idialoa
Select All

— o

Figure 16: Installation of e? studio — Device Families

5. Extra Features
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For
non-English language users, please select Language packs at this step if needed.
Click the [Next] button to continue.

- Renesas e* studio 2024-07 Setup =1 E3]

Renesas e? studio 2024-07 Setup

Select the extra features you wish to install u tE N E SAS

Welcome g Japanese Language Support
Device Families e
@ Extra Features : Chinese (Simplified) Language Support
)
Chinese (Traditional) Language Support
=)
— Git Integration
=)
Git SCM Support
Terminals

)
- ANSIVE102 compatible Terminal support for Serial. ssh and Telnet

Select All

= Back concel

Figure 17: Installation of e? studio — Extra Features
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6. Customize Features
Select the components to install and click the [Next] button to continue.

] Renesas e* studio 2024-07 Setup I=1]E3]

RENESAS
Select the components you want to install.

Welcome & ) Kenesas LA Family SUPPOIT 124./.U.K2UZ4Ub20- 18U/

Renesas e? studio 2024-07 Setup

Device Families
Renesas FSP Smart Configurator Core (9.6.0.v20240619-0945)
Extra Features
B ERTTEE Renesas FSP Smart Configurator ARM (9.6.0.v20240619-1422)
Features -

& Renesas QE .Cnmmnn Components (24.7.0.R20240620-1807)
(it integration for Eclipse (6.9.0.202403050737-r)
« () Additional Tools (24.7.0.R20240620-1807)
% () T™ Terminal (4.6.0)
Djapanes‘e .I._angua.g.e Support (4.5.100)
< [[J Chinese (simplified) Language Support (4.5.100)
4 () Chinese (Traditional) Language Support (4.5.100)
() embedded C/C++ }Link Debugging (6.4.0.202405200840)
select All Optional  Deselect All Optional

Size of install: 874.7 MB

< pack Cancel

Figure 18: Installation of e? studio — Features

7. Additional Software

Select additional software (i.e., compilers, utilities, QE...) to be installed. Be sure to select the “GNU

ARM Embedded 12.2-Rel1” and click [Next >] to continue.

(] Renesas e? studio 2024-07 Setup @lx]

Renesas e? studio 2024-07 Setup

Select the additional software you wish to install | zE N ESAS

Welcome Renesas QE
Device Families ~ k4 Renesas Al
& .
Extra Features . Renesas Al Navigator 110
Al Transfer Learning Tool Plugin 1.1.0
Customise i .
Cerie 3 A1 Model Conversion Tool Plugin 1.1.0
Renesas Toolchains && Utilities
Additional + B GEC Toolchains & Utilities
Software 2 GNU ARM Embedded 12.2-Rell 12.2.1.arm-12-24 1000 B
GNU ARM Embedded 10.3 2021.10 10.3.1.20210824 1000 B
GNU ARM Embedded 9.3.1 202092 9.3.1.202092 1000 B

GCC ARM A-Profile (AArch64 bare-metal) 13.2.Rell 13.2.1.20231009 1000B
GCC ARM A-Profile (AArch64 bare-metal) 10.3 2021.07 10.3.0.2021-07 1000B
Renesas RA FSP

340.2 MB download required

= fack canee!

Figure 19: Installation of e? studio — Additional Software
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8. License Agreement

Read and accept the software license agreement. Click the [Next] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.

- Renesas e* studio 2024-07 Setup =13
Renesas e? studio 2024-07 Setup
RENESAS
Welcome Please read and accept the following Software Agreements
Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio

Extra Features OpenJDK License AQreem ri,ic gonesas e2 studio license agreement ("Agreement”) is

Customise ARM Ds-5 Toolchain Inte¢ between the entity on whose behalf you are entering into this

Features 1AR Plugin Manager Agreement (“Client") and Renesas Electronics Corporation, a
Japanese company with its registered office at 3-2-24, Toyosu,

Additional Koto-ku, Tokyo 135-0061, |apan ("Renesas”). YOU SHOULD READ

Software THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A BINDING
CONTRACT BETWEEN CLIENT AND RENESAS.

@ (e The Renesas IDE Software (defined below) is intended for

commercial use by a company or corporation enly and is not
designed, developed or produced for any private use or purpose.
If you are an individual, or you intend to install the Renesas IDE
Software on behalf of an individual, or the Renesas IDE Software
is expected to be used for a private purpose directly or indirectly,
you should click "No" en the installer.

Otherwise, by clicking the "I accept” button or other button or
mechanism designed to acknowledge agreement to the terms of
an electronic copy of this Agreement, or by installing, accessing,
or otherwise copying or using all or any portion of the Renesas
IDE Software, you accept this Agreement on behalf of the entity
for which you are authorized to act (e.g., an employer) and
acknowledge that such entity is legally bound by this Agreement
and you represent and warrant that you have the right, power and
authority to act on behalf of and bind such entity (if any) and
yourself

IF YOU DO NOT AGREE TO THE TERMS CONTAINED IN THIS
AGREEMENT, OR IF YOU DO NOT HAVE THE RIGHT, POWER AND
AUTHORITY TO ACT ON BEHALF OF AND BIND SUCH ENTITY, DO

I I accept the terms of the Software Agreements print all...

< pack caneel

Figure 20: Installation of e? studio — Licenses

9. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

Note: If 2 studio was installed in another location, it is recommended to rename to distinguish from the other
e? studio(s).

| Renesas e’ studio 2024-07 Setup [=0[ES
Renesas e? studio 2024-07 Setup
RRENESAS
Welcome Shortcuts to important programs and files will be created in the following locations:

Device Families
In the application launcher

Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

e
Shak Sk

Figure 21: Installation of e? studio — Shortcuts
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10.Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to
install the Renesas e?studio IDE.

[} Renesas e? studio 2024-07 Setup [} /7‘

RENESAS

Ready to install
Software to install:
* Renesas e2 studio v24.7.0.R20240620-1807

* Java Runtime v17.0.0

Customise * 1AR Plugin Manager v1.1.0.202007251457

Features. * Renesas e2 studio Common Components (Lite) v24.7.0.R20240620-1807
= Renesas e2 studio Common Components (Full) v24.7.0.R20240620-1807

Additional * Renesas e2 studio Common Components for ARM Devices

Software v24.7.0.R20240620-1807

» Renesas e2 studio Tools v24.7.0.R20240620-1807

* Renesas RZ Family Support v24.7.0.R20240620-1807

* Renesas FSP Smart Configurator Core v9.6.0.w20240619-0945

* Renasas FSP Smart Configurator ARM v9.6.0.vw20240619-1422

* Renesas QE Common Components v24.7.0.R20240620-1807

= ARM DS-5 Toolchain Integration v1.0.5.v20240408-1026

» Eclipse CDT Linker Script Editor and DSL v1.0.112.v20240408-2044

* GCC for Renesas RZ Build Support v24.7.0.v20240613-0901

* GCC for Renesas RZ Support Files v24.7.0.v20240513-0255

* Just] Adoptium Open|DK Hotspot JRE Complete v17.0.10.v20240120-1143

» Renesas Build Support Files v9.6.0.v20240408-1639

* Renesas CMake Build Support Files v9.6.0.v20240408-1639

* Renesas Common Project Import/Export v9.6.0.¥20240606-0906

* Renasas Debug Views v9.6.0.v20240607-0813

* Renesas Debug Views (Lite) v9.6.0.v20240607-0813

* Renesas QE common v2.2.2.v20240408-1831

* Renesas RTOS Debug Views v9.6.0.v20240530-1615

* Renesas RZ Debug Support v24.7.0.v20240408-2031

» Renesas RZ Debug Support Files v24.7.0.v20240622-0251

* Renesas Smart Configurator for RZ v24.7.0.v20240620-0854

* Renesas Smart Help v9.6.0.v20240521-0307

* Renesas e2 studio ARM Common Debug v9.6.0.v20240520-0840

* Renesas e2 studio ARM Common GCC Build v9.6.0.v20240520-0840

—
< Back ext Cancel Install

Renesas e? studio 2024-07 Setup

Welcome
Device Families

Extra Features

Licenses

Shortcuts

@ Summary

11.Installing...

Figure 22: Installation of e? studio — Summary

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process.

12.Results

Click the OK button to complete the installation.

[m] Renesas e* studio 2024-07 Setup =13

RENESAS

Renesas e? studio 2024-07 Setup

Welcome Installation of 2 studio is complete.

Device Families Please click OK to close.

Extra Features
Launch e2 studio?

Customise

Features (G view Release Notes?

5 view What's New?
Additional
Software
Licenses
Shorteuts
Summary

installing...

@Resu\ts

Figure 23: Summary Page
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2.2 FSP setup

2.2.1 Installation of FSP using Package Installer
Package Installer RZV_FSP_Packs_v2.0.2.exe is showcased at here. This section describes the procedure
for installation. Note that it's for Windows Host PC only.

1. Quit e? studio.

2. Invoke RZV_FSP_Packs_v2.0.2.exe.
3. Click [Next >] to start the installation.

Renesas Flexible Software Package
(FSP) Installer

This installer will install FSP packs and documentation into an
existing e2 studic installation
The documentation will be available at

<INSTALL_DIRECTORY/fsp_documentation/rzv/<VERSION

The source for FSP can be found at
https://github.comjrenesas/rzv-fsp

=

Figure 24: FSP Package Installer

4. See the license term and click [I Agree] if it's acceptable.

RZV¥ FSPv2.0.2

- z E N ESAS Please review the license terms before instaling Renesas RZV

FSPv2.0.2,

If you accept all terms of the agreement, dick I Agree.

Figure 25: FSP License Term

RO1AN6240EJ0202 Rev.2.02
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5. Specify e? studio installation folder (e.g., C:\Renesas\e2studio) and click [Install].

Choose Install Location

- z ENES/AS  hoose the folder in which to install Renesas R2V FSP v2.0.2.

The installation path must point to the root of the e2 studio installation (e.g.
C:¥Renesas¥e2_studio). Please make sure e2 studio is dosed before installation.

Browse to folder where 2 studio is installed

C:¥Renesas¥e2_studio¥ |

Space required: 51.2 M8
Space available: 24.8 GB

=

Figure 26: Browse to the folder where e? studio is installed

6. Click [Finish] to complete the installation.

Completing Renesas RZV FSPv2.0.2
Setup

Renesas RZV FSPv2.0.2 has been installed on your
computer.
Click Finish to dose Setup.

EA9pen v dogumentation for this release]

Click here to visit the FSP GitHub repository

Figure 27: Completion of FSP Installation

If the box Open up documentation for this release is checked at that time, FSP documentation for the
installed version of FSP should be opened.

RO1AN6240EJ0202 Rev.2.02 Page 19 of 62
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222

Installation of FSP Pack using Package Zip file

No package installer is available for Linux Host PC. Thus, you need to install FSP with the zip file
RZV_FSP_Packs_v2.0.2.zip. This section describes the procedure for installation.

1. Download RZV_FSP_Packs_v2.0.2.zip from here.
2. Extract the zip file to e? studio installation directory. If it's successfully extracted, rz_fsp/rzv/packs should
be placed at <e2 studio installation directory>/Internal/projectgen.

4 | « internal > projectgen | rzfsp > rzv > packs

[ Amazon FreeRTOS-Kernel.10.4.6 +sp.2.0.2 pack

[ Arm CMSIS5.5.8.0+ renesas 0.fsp.2.0.2. pack

[ Linaro.0penAMP.1.00+fsp.2.0.2. pack

[ RenesasRZV.2.0.2.pack

[ RenesasRZV_baremetal _blinky.2.0.2 pack

[T RenesasRZV_baremetal_blinky_cm33baot.2.0.2 pack
[ RenesasRZV_baremetal_blinky_cr8.2.0.2.pack

[ RenesasRZV_baremetal_minimal_cm33boot.2.0.2.pack
[] RenesasRZV_baremetal_minimal_cr8.2.0.2. pack

[ RenesasRZV_board_custom.2.0.2.pack

[ RenesasRZV_board_rzv2h_evk.2.0.2.pack

[ RenesasRZV_board_rzv2l_smarc.2.02.pack

|| RenesasRZV_freertos_blinky.2.0.2.pack

[ RenesasRZV_freertos_blinky_cm33b00t2.0.2 pack
[ RenesasRZV_freertos_blinky_cr8.2.02.pack

[] RenesasRZV_freertos_minimal_cm33boot20.2 pack
[T RenesasRZV_freertos_minimal_cr8.2.0.2.pack

[ RenesasRZV_mcu_rzv2h20.2 pack

[ RenesasRZV_mcu_rzv21 2.0 2 pack

[ ] SEGGER JLink 7.96.5.pack

3. Atthe 1stinvocation of e? studio after the extraction, FSP should be automatically installed.

Figure 28: FSP Packs on e? studio installation directory

4. You can check if the installation is successfully done by the procedure below:

Click Help > CMSIS Packs Management > Renesas RZ/V

workspace - test/configuration.xmi - e* studio
Renesas Views Run RenesasAl Window Help
& welcome Q B |

% Help Contonts

0 [test] FSP Configuration X

Summary

Project Summary

Board: : RZ/V2H Evaluation Kit
Device: : RIADSGOSTHAAGBG
Core: ; Core 6(CM33_0)

Toelchain: : GCC for Renesas RZ
Toolchain Version: | 12.2.1.arm-12-24
FSP Vorsion: | 2.00

Project Type: : Flat

[ ga | & VE3Y

Search

Show Context Help »

@ install New Software,

& Eclipse Marketplace
bedded Workbench plugin manager.

@ About &* studio

Figure 29: CMSIS Packs Management (1)

o If FSP is successfully installed, 2.0.2 should be listed under FSP as shown below:

Packs location:

Show in System Explorer...

Available Packs

Category
~ (@] Fsp
= 202

() Generic

Version  Status

Figure 30: CMSIS Packs Management (2)
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3. Setup a SMARC EVK
3.1 Set up an RZ/V2L SMARC EVK

Below is an example of a typical system configuration.

e? studio

SEGGER J-Link 1)

(*1) J-Link 9-pin Adapter ~ RZ/V2L SMARC EVK

Figure 31: System Configuration Example — RZ/V2L SMARC EVK

3.1.1 Supported Emulator
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.1.2 Board Setup
3.1.21 Boot MODE

To set the board to Boot mode 3(QSPI Boot(1.8V) Mode), set the SW11 as below.

SCIF Download mode(*1 QSPI Boot (1.8V) Mode
BOOT/Power Mode Select BOOT/Power Mode Select
B L]

E{ lij']l

Saas

eMMC Boot (1.8V)Mode
BOOT/Power Mode Select

LU S

L
SW11:Mode Setting switch
DIP-Switch-4pol-SMD
y, ;3w 8 BOOT_SELO#
2 =l i BOOT_SEL1#
3 = 6 00T_SEL2#
4 e 5 BUS_MIN
(*1) SCIF boot mode is the mode used for writing such as u-boot
4 This mode that operates only with the built-in ROM and can be used for minimum board confirmation
- See section "How to check the operation of the board"
Figure 32: Boot MODE
RO1ANG6240EJ0202 Rev.2.02 Page 21 of 62
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3.1.2.2 JTAG connection
When connecting JTAG, you must set the DIP SW1 settings as follows:

CN2 : JTAG 10pin ARM standard connector

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

Connect

CN1 is a connector for analog signal input. Please careful not to accidentally connect
the JTAG cable.

SW1-1 | DEBUGEN | sW1-2 | microSDieMMC selection
OFF __ JTAGdebugmode | OFF  Select eMMC on SMARC Module
ON  Normal operation OoN Select microSD slot on SMARC Module

The selection of microSD slot and eMMC on the SMARC module is exclusive

Figure 33: JTAG connection

Please note that RZ/V2L SMARC EVK has CoreSight 10 connector and therefore, the following adapter must
be needed to connect Segger J-Link.

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/

3.1.2.3 Debug Serial (console output)
Debug serial uses CN14. The baud rate is 115200bps.

CN14 : USB Type-microB Connector used as SCIF3

USB Type-microB cable

CN14:USB Type-microB Connector

Figure 34: Debug Serial (console output)

RO1AN6240EJ0202 Rev.2.02 Page 22 of 62
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3.1.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Ill 65W Pod (manufactured by Anker)

I CN6 : USB Type-C Connector for Power Supply
I

To USB-PD
m- Power Charger

USB Type-C cable

Figure 35: Power Supply

Connect USB-PD Power Charger to USB Type-C Connector. Then LED1(VBUS PWR On) and LED3
(Module PWR On) lights up. Press SW9 to turn on the power. Then LED4(Carrier PWR On) lights up.

Note: When turn on the power, press and hold the power button for 1 second.
When turn off the power, press and hold the power button for 2 seconds

Figure 36: LED Status after Turning on EVK
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3.1.2.5 How to check the operation of the board

First, check the board for problems. There are two ways to do this. Please check with either.

BOOT MODE: QSPI Boot(1.8V) Mode

If u-boot is written to the serial flash, when the power is turned on, the following will be output to the
console(CN14).

¥ COM10 - Tera Term VT - [m] x

) ES) I

BOOT MODE: SCIF Download Mode
When the power is turned on, the following will be output to the console (CN14).

[ COMA46 - Tera Term VT - m] X
AP |EE BES IWRO-LO) HUEIW)  ALTH)

RO1ANG240EJ0202 Rev.2.02 Page 24 of 62
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3.2 Setup an RZ/V2H EVK

Below is an example of a typical system configuration.

e? studio

SEGGER J-Link

(*1) J-Link 9-pin Adapter R/V2|-| EV a

Figure 37: System Configuration Example — RZ/V2H EVK

3.21 Supported Emulator
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.2.2 Board Setup
3.2.21 Boot MODE

Set the boot mode using the DSW1 shown in the figure below.

Figure 38: Boot MODE
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Select the boot mode with the following settings.

Switch No. Function
1 Select the cold boot CPU
OFF: CM33/ ON: CA55
2 Input the CAS55 frequency at the CA55 cold boot.

[SW2:SW3] =[OFF:OFF] : 1.6GHz
=[OFF : ON] : 1.7GHz [defaull]

3 =[ON : OFF] : 1.1GHz
=[ON : ON] : 1.5GHz
4 Input the boot mode select signal.

[SW4 : SW5] =[OFF : OFF] : xSPI
=[OFF:ON] : SCIF

5 =[ON : OFF] : SD
=[ON : ON] : eMMC

6 OFF: SSCG OFF / ON: SSCG ON

7 OFF: Normal mode / ON: Debug mode

8 Fix OFF

3.2.2.2 JTAG connection
When connecting to JTAG, you must set the DSW1 Switch No.7 settings as ON.

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

connect

Figure 39: JTAG connection

Please note that RZ/V2H EVK has CoreSight 10 connector and therefore, the following adapter must be
needed to connect Segger J-Link.

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.2.2.3 Debug Serial (console output)
Debug serial uses CN12. The baud rate is 115200bps.

To PC

connect
USB Type-microB cable

Figure 40: Debug Serial (console output)

3.2.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB PD Charger MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI)
e USB Type-C cable included with MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI)

Check that the power slide switch SW2 and SW3 are turned OFF.

Figure 41: Power Supply
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Connect USB-PD Power Charger to CN13.
Turn the SW3 ON, then LD2 and LD7 light up.
Turn the SW2 ON, then LD1, LD3 and LD4 light up.

To USB-PD
] ﬁema;- Power Charger

USB Type-C cable

Figure 42: Power Supply
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4. Tutorial: Your First RZ MPU Project - Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of
creating a simple application using e? studio and running that application on an RZ MPU board.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microprocessors. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microprocessor is alive, the clocks are running, and the memory is initialized.

e Timer (GTM) interrupt is intentionally fired and GPIO is properly controlled.

Note: RZ/V2H EVK has on-board LED but RZ/\V2L SMARC EVK board does not have any LED.
Thus, Blinky sample application for RZ/V2L SMARC EVK is designed to use the Pmod module
described below alternatively:
e Pmod LED (Four High-brightness LEDs): https://reference.digilentinc.com/pmod/pmodied/start

This module is not included on the RZ/V2L SMARC EVK board and so, please prepare it beforehand.

Figure 43: Connection Pmod LED module (410-076)
In the case of RZ/V2H EVK, the on-board LED is placed as below.

Figure 44: On-board LED of RZ/V2H EVK
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4.3 Create a New Project for Blinky

The creation and configuration of an RZ/V C/C++ FSP Project is the first step in the creation of an
application.

The base RZ/V pack includes a pre-written Blinky example application.
Follow these steps to create an RZ MPU project:

1. In e? studio, click File > New > C/C++ Project.

&) work - & studio

File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project v &
Open File... [ Makefile Project with Existing Code
=} Open Projects from File System... [c] C/C++ Project l} M

Recent Files

> 4 Project..

Figure 45: New C/C++ Project
2. Select [Renesas RZ] > [Renesas RZ/V C/C++ FSP Project] and Click Next.

Mew C/C++ Project [m] x
)

Templates for New C/C++ Project

All Renesas RZ/G C/C+ + FSP Project -
CMake FEn Creote on executable or static library C/C++
Make FSP project for Renesas RZ/G.

Renesas Debug

R R Renesas RZ/T C/C++ FSP Project

=== Creote on executable or stotic library C/Cee
FSP project for Renesas RZ/T.

Renesac RA
Renesas RZ

Renesas RZ/V C/C+ + FSP Project
P~ Create an exscutoble or static librory C/C++
F5P project for Renesas RZV.

2 « Back - Cancel

Figure 46: Renesas RZ/V C/C++ FSP Project

3. Assign a name to this new project. Blinky is a good name to use for this tutorial.
4. Click Next. The Project Configuration window shows your selection.

B Renesas BZV C/Cs = FSP Posject o x

Fenesas RZ/V €/C+ « PSP Project —
tion

? B e

Figure 47 : e? studio Project Configuration window (part 1)
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5. Select the board support package by selecting the name of your board from the Device Selection drop-

down list. Select GNU ARM Embedded in Toolchains and version is 12.2.1.arm-12-24 and Click Next.

9 Reneass iz Cice- 150 Project

0ox
Renesas RZ/V C/C++ FSP Project
Device and Tocls Selection
Device Selection
[ veriers 202 7] o Osreton
Boare REAVZH Evaluation Kil
Device ROACOGOSTHAAGEG
core Core EM31.0) | Device Detais
Llangiage: @€ OC++ TstZone to
o 1368
Processor Cortex 133
Tocichains Dobugger
G ARM Embedided -tink ARM v
anage Tosic i
@ Back Cancel

Figure 48 : e? studio Project Configuration window (part 2)

6. Select the build artifact and RTOS. Be sure that on the current version, Secure should always be

chosen at the Sub-core start state. Otherwise, the created project can’t be built successfully.

{8 Renesas RZ/V C/C+ + FSP Project

Renesas RZ/V C/C++ FSP Project

Build Artifact, RTOS Selection and Sub-Core Selection

Build Artifact Selection

® Executable
« Project bulles to zn executable file

© static Library
« Project bullds to a statie library file
) Executable Using an RZ/V Static Library
« Project bulds 10 an executable file
= Praject uses an existing RZ/V static library project

Sub-core start state

O Non-secure
= Start sub-care in non-secure state

(&

0 %

RTOS Selection

Figure 49 : e? studio Project Configuration window (part 3)

B Fenesas RV C/Co s FSP Project

7. Select the Blinky template for your board and click Finish.

Renesas RZ/V C/C++ F3P Project

Frojest Template Selection

Project Tenplate Seiectson

o x

® | Bare Metal - Blinky

the € runtinme emvirenment.

[Renesas RZVIL 1 0.0 pack]

Baee metal P3P pregect that inchades BSP aned will blink LEDs f svadable. This project willinftisfize clocks, ping, stacks, snd

~ Bare Metal - Minimal

[Renesas. RZVZL1 2.0 pack]

Code Generation Seftings
] Use Rersesas Code Foemattes

<Back

Templates for RZ/VV2L

f.’.‘} Bare metal FSP progect that inchades BSP. This project will iniialize clocks. pans, stacks, and the C nntime ervwironment,

Cancel

8 Renesas RZ/V (/C+ + FSP Project

Renesas RZ/V C/C++ FSP Project

Project Template Selection

Project Template Selection

® d‘ Bare Metal (CM33) - Blinky

pins, stacks, and the C runtime environment
[Renesas.RZV.2.0.1.pack]

Bare metal FSP project of Cortex-M33 core that includes BSP and will blink LEDs if available. This project will initialize clocks,

Bare Metal (CM33) - Minimal

O (.}

[Renesas.RZV.2.0.1.pack]

Code Generation Settings
[ Use Renesas Code Formatter

< Back Next

Bare metal FSP project of Cortex-M33 care that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime
.

Cancel

Templates for RZ/V2H

Figure 50

: % studio Project Configuration window (part 4)
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Once the project has been created, the name of the project will show up in the Project Explorer window
of e? studio. Now click the Generate Project Content button in the top right corner of the Project
Configuration window to generate your board specific files.

%5 [Blinky] FSP Configuration > =
Summary Generate Project Content
Project Summary A
RENESAS
Board: RZ/V2H Evaluation Kit
Device: RSAD9GOSTHA4GEG
Core: Core 6(CM33_0)
Toolchain: GCC for Renesas RZ
Toolchain Version: 12.2.1.am-12-24
FSP Version: 202
Project Type: Flat
Location: Cuiworkiv2h/Blinky |

Selected software components

Figure 51 : e? studio Project Configuration tab

e Your new project is now created, configured, and ready to build.

RO1AN6240EJ0202 Rev.2.02 Page 32 of 62
Oct.04.24 RENESAS




RZ/N2L, RZ/V2H Getting Started with Flexible Software Package

4.3.1 Details about the Blinky Configuration
The Generate Project Content button creates configuration header files, copies source files from templates,
and generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project
Content button, all the files necessary for the inclusion of that module into the project will be copied or
created. If that same check box is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e? studio for the Blinky application. The clock
configuration tab (see 5.2.3 Configuring Clocks) shows the Blinky clock configuration. The Blinky clock
configuration is stored in the BSP clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e? studio for the
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components
The Blinky project automatically selects the following HAL components in the Components tab:

e r_gtm
e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL window
for the respective driver (see 5.2.8.Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in < project >/rzv_gen/main.c. It is one of the files that are generated during the
project creation stage and only contains a call to hal_entry(). For more information on generated files, see
5.2.8.Adding and Configuring HAL Drivers.

4.3.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e? studio when you select the
Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

Get the LED information for the selected board by bsp_leds_t structure.

Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired.
Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.

Toggle the LEDs by writing to the GPIO pin with “R_BSP_PinWrite((bsp_io_port_pin_t) pin, pin_level)” in
callback function of GTM that is called with the specified interval.

i
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4.4 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:
1. Click on Project in the menu bar and select Build Project.

2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

& work - Blinky/configuration.xml - &* studio

o= 2
K || 4+ || ® | | 5 Debug v || &7 Blinky Debug_Flat

& C/Cs+ §B% ESP Configura
Y,

File Edit MNavigate Search enesas Views Run Windov

a. Project -> Build Project

b. Click hammer icon

{5 [Blinky] FSP Configura
& [Blinky] FSP Configura ¢. Right click -> Build Project

Project Summan
Board:

Device:
Toolchain:

Figure 52 : e? studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the final

image file name and section sizes in that image.

[ Pin Conflicts JEREESTER
[CDT Build Console [Blinky]
"arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+notp -tdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
arm-none-eabi-gcc @"Blinky.elf.in™
arm-none-gabi-cbjcopy -0 srec “"Blinky.elf" "Blinky.srec”
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4812 2872 16784384 16791188 103694 Blinky.elf

@5:35:14 Build Finished. @ errors, @ warnings. (tock 7s5.823ms)

Figure 53 : e? studio Project Build console
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4.5 Debug the Blinky Project

4.5.1 Debug prerequisites
To debug the project on a board, you need

e The board to be connected to e? studio
e The debugger to be configured to talk to the board
e The application to be programmed to the microprocessor

Applications run from the internal ram or external ram of your microprocessor. To run or debug the
application, the application must first be programmed to ram by JTAG debugger. SMARC EVK board has an
JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug steps

To debug the Blinky application, follow these steps:
1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run Window Help

Renesas Device Partition Manager

@ Tracex &
B Tracealyzer >
@, Run Ctrl+F11
*, Debug F11

Run Histary > |
©@ RunAs >

Run Configurations...

Debug History >
4 Debug As >

| Debug Configurations.. |

Q. External Tools >

Figure 54 : e? studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger Configurations ...

no launch history

Debug As >
I Debug Configurations... I

Organize Favorites...

Figure 55 : e? studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the
New icon in the top left corner of the window. Once selected, the Debug Configuration window displays
the Debug configuration for your Blinky project.

RO1AN6240EJ0202 Rev.2.02 Page 35 of 62
Oct.04.24 RENESAS




RZ/\V2L, RZIN2H

Getting Started with Flexible Software Package

{8 Debug Configurations o
Create, manage, and run configurations ﬁ\
FeEX B Y- Name: [Blinky Debug

[type filter text ||| OB 5 oebugger| i Startup] & Source] ] Common

[T] C/C++ Application Project

[E] C/C++ Remote Application

1 EASE Script [Blinky Browse...

[£] GDB Hardware Debugging C/C++ Application:

[£] GDB OpenOCD Debugging [DebugyBinky.lf

£ GDB Simulator Debugging (RHES0)

[ Java Applet Variables... Search Project... Browse...

[5] Java Application Build (if required) before launching

& Launch Group

[T Remote Java Application Build Cenfiguration: | Use Active ~
[ Renesas GDB Hardware Debuggin

EE Blinky Debug gand O Enable auto build O Disable auto build

[£7] Renesas Simulator Debugging (R¥, RL78) (®) Use workspace settings Configure Workspace Seftings...

Revert Appl

Filter matched 13 of 15 items Sve B

Figure 56 : e? studio Debugger Configurations window with Blinky project (1)

3. Select the debug configuration for the generated project and select the Debugger tab.
4. Click Debug to begin debugging the application.
5. Extracting RZ Debug.

B Progress Information o x
0 Preparing launch delegate...

Configuring GDB
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4.5.3 Details about the Debug Process
In debug mode, e? studio executes the following tasks:

1.

oo

Downloading the application image to the microprocessor and programming the image to the internal
and/or external memory.

Setting a breakpoint at main().

Setting the stack pointer register to the stack.

Loading the program counter register with the address of the reset vector.

Displaying the startup code where the program counter points to.

Program Counter

4% [Blinky] RA Configyfation €] hal_entry.c [g startup.c 23

@ * MCU starts executing here out of re
~void Reset_Handler (void)
Beeaeals i

/* Initialize system using BSP. */
BBEERala SystemInit();

/* Call user application. */
Boeeaals main();

while (1)
1]

Figure 57 : e? studio Debugger memory window

4.5.4 Run the Blinky Project
While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 58 : e? studio Debugger Play icon

The LED (RZ/V2L SMARC EVK: Pmod LED, RZ/V2H EVK: On bord LED) should now be blinking.
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5. FSP application launch with e? studio

This section describes how to create project and debug in single core environment. Please refer to the
section 6 for the multi-core project creation and debug in RZ/V2H.

5.1 Creating a Project
5.1.1 What is a Project?
In e2 studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves:

1. Create a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after
you launch e? studio and select a workspace, all projects previously saved in the selected workspace are
loaded and displayed in the Project Explorer window. Each project has an associated configuration file
named configuration.xml, which is located in the project's root directory.

(5 Project Explorer X
+ |5 Blinky [Debug]
& Binaries
hill Includes
@ v
B rov_gen
3 sre
= Debug
&= rov_cfg
= seript
Blinky Debug_Flat.jlink
Blinky Debug_Flat.launch
{8} configurationaml
RSADTGO54L236B6. pincfg

Figure 59 : e? studio Project Configuration file

Double-click on the configuration.xml file to open the RZ MPU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner
of the e? studio window. Once selected, you can use the editor to view or modify the configuration settings
associated with this project.

i | B2 C/C++ & FSP Configuration

Figure 60 : e? studio FSP Configuration Perspective

Note: Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ
Project Report file (rzv_cfg.txt) with all the project settings is generated. The format allows differences
to be easily viewed using a text comparison tool. The generated file is located in the project root

directory.
M Project Explorer x rzv_cfgtat X
v &5 Blinky | De FSP Configuration ~
& Binaries Board "RZ/V2L Evaluation Kit (SMARC)"

ROAB7GO54L236BG
part_number: RIAB7GO54L23GBG

Includes

rom_size_bytes: @
rzv_gen ram_size_bytes: 131072
package_style: LFBGA
package_pins: 456

RZV2L
series: 2

RZV2L Family

RZ/V2L Common

stack size (bytes): 0x200
ack size (bytes): 9x200
Heap size (bytes): @

MCU Vee (mV): 3300

Parameter checking: Disabled
Assert Failures: Return FSP_ERR_ASSERTION
Error Log: No Error Log

PFS Protect: Enabled

C Runtime Initialization Enabled

Mair

Figure 61 : RZ Project Report
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The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed
in the following sections.

Note: The tabs available in the RZ Project Editor depend on the e? studio version and the layout may vary
slightly, however the functionality should be easy to follow.

4t [Blinky] FSP Configuration X =0
Summary Generate Project Content
Project Summary

RENESAS

Boara: RZAV2H Evaluation kit
Device: RIADSGOSTHA4GEE
Core: Core 6(CH33_0)
Toolchain: GGG for Renesas RZ

(chain Version: 122.1.am-12-24
FSPVersiom: 202
Project Type: Flat
Location Corki2nBlinky <5

Selected software components

Simple application that blinks an LED. No RTOS included
Board Support Package Gommon Files 202
100 Port 202

202

202

terface Flash on Expanded Serial Peripheral Interface v2.0.2
ore () V5.8.041enesas 0.15p.2.0.2
Board support package for ROAG9GOSTHA4GES
Board support package for RZV2H

Board support package for RZV2H (RZV2H) - FSP Data

Evaluation Kit RZIV2H Support Files (RZIV2H)

D

I Summary | BSP| Clocks | Pins| Interrupts | Event Links| Stacks | Components|

202
202
202

Figure 62 : RZ Project Editor tabs

5.1.2 Creating a New Project
For RZ MPU applications, generate a new project using the following steps:
1. Click on File > New > C/C++ Project.

&) work - & studio

File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help
New Alt+Shift+N » Renesas C/C++ Project =

Open File...

5]

@ Makefile Project with Existing Code
[©] C/C++ Project I} M
> 9 Project..

[} Open Projects from File System...

Recent Files

Figure 63 : New RZ MPU Project

2. Then click on the Renesas RZ/V C/C++ FSP Project template for the type of project you are creating.

BB New C/C++ Project u] X
Templates for New C/C++ Project
Al Renesas RZ/G C/C+ + FSP Project ~
CMake == Create on executoble or static library C/C++
Make F5P project for Renesas RE/G.
Renesas Debug
Renesas RZ/T C/C++ FSP Project
=== Creote on executable or stotic library C/Cee
FSP project for Renesas RZ/T.
Renesas RZ/V C/C-+ + FSP Project
P~ Create an exscutoble or static librory C/C++
F5P project for Renesas RZ/V.
@ Next > Cancel

Figure 64 : New Project Templates
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3. Select a project name and location.

B Renesas RI/V C/Ce « PSP Prsject

Renesas RZ/V C/Ce o FSP Project

Prcgect Mame and Location

Cameel

Figure 65 : RZ MPU Project Generator (Screen 1)

4. Click Next.

5.1.2.1 Selecting a Board and Toolchain

In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or select
Custom User Board for any of the RZ MPU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection. Only change
the Device when using the Custom User Board (Any Device) board selection.

4. Select the Core. You can select Core 6(CM33_0), Core 4(CR8_0) or Core 5(CR8_1) if you selected

RZ/V2H for the Device.

No o

8. Select the Debugger. The J-Link Arm Debugger is preselected.

9. Click Next.

To add threads, select RTOS, or No RTOS if an RTOS is not being used.
The Toolchain selection defaults to GNU Arm Embedded.
. Select the Toolchain version. This should default to the installed toolchain version.

@ Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

Device and Tools Selection

Device Selection

FSP Version: 202

Board; RZ/V2H Evaluation it
Device: RIAOIGOSTHA4GEG
Core: Core 6(CM33.0)

Language: @ C OC++

GNU ARM Embedded

| Board Description

f221am-12-24

aaaaaaaaaaaaaaaa

Figure 66 : RZ MPU Project Generator (Screen 2-1)

If Core 4(CR8_0) or Core 5(CR8_1) is selected in procedure 4, you need to select the preceding project.
To select the preceding project when creating the Core 4(CR8_0) or Core 5(CR8_1) project, it is required to
prepare Core 6(CM33_0) before Core 4(CR8_0) or Core 5(CR8_1) project creation.
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{8 Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

Preceding Project or Smart Bundle Selection

I @ Preceding Project:  Blinky I
s—

Choose this option if you have access to the project source code of the preceding processor core or security context.
O Smart Bundle:

Workspace. File System. Variables.

Preceding Project/Smart Bundle Details

FSP version 202

Toolchain GNU ARM Embedded
Toolchain version 12.21.arm-12-24
Board RZ/V2H Evaluation Kit
Device RIAQYGOSTHA4GBG
Core cM33.0

Zones CM33.0S

@ B s =

Figure 67 : RZ MPU Project Generator (Screen 2-2)

5.1.2.2 Selecting a Project Template

In the next window, select the build artifact, Sub-core start state and RTOS. Be sure that you select Secure
as Sub-core start state in the current version.

{8 Renesas RZ/V C/C++ FSP Project

[m] X
Renesas RZ/V C/C++ FSP Project —
Build Artifact, RTOS Selection and Sub-Core Selection
Build Artifact Selection RTOS Selection
@ Executable No RTOS ~

® Project builds to an executable file

() Static Library
® Project builds to a static library file

(O Executable Using an RZ/V Static Library
* Project builds to an executable file
® Project uses an existing RZ/V static library project

Sub-core start state

@ Secure
® Start sub-core in secure state

() Non-secure
® Start sub-core in non-secure state

) < Back Finish Cancel

Figure 68 : RZ MPU Project Generator (Screen 3)
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In the next window, select a project template from the list of available templates. By default, this screen
shows the templates that are included in your current RZ/V MPU Pack. Once you have selected the

appropriate template, click Finish.

Note: If you want to develop your own application, select the basic template for your board, Bare Metal -

Minimal or FreeRTOS - Blinky.

D) Renesas BZA £/« BSP Project &
| Renesas RZ/V C/C+~ FSP Project
Pgjuct Template Sebection

Pusject Template Seiection

® | Bare Metal - Blinky

Bare mesal FSP project that includes BSP and will bink LEDs if availaite. Tnis peoject wil i
e C runtime emvironment.

[Renesas.RZV2L1.00,pack]

tocks, pins, stacks, and

Bare Metal - Minimal
Bare metal F5P project that includes B5P, This progect will initiskoe docks, ping, stacks, and the C runtime environment.
[Renesas AZVIL1.00pack]

=

Code Generation Seftings
[ Use Remesss Code Formatter

» D Penesa B2V

Renesas RZ/V C/C+~ FSP Project
Preject Template Selection

Prcject Template Sebection

| FreeRTOS - Blinky - Static Allocation

o

allocaticn
LEDs weill &

[Reness:

or

| A0pack]

Code Generation Settings
A Use Remenss Code Formatter

® | FreeRTOS - Blinky - Dynamic Allocation
Wt | FreeRTOS PSP project that inchudes BSP and will blink LEDs if available. FreeRTOS is pre-configured for dynamic memary
altocaticn. Thiss paoject willin) Al wsing reeRTOS will i 1
LEDs wil be started.
[Renesas RZVILA A Dpack]

FreaRTOS F5P progect that includes BSP and will link LEDs if svailable. FreeRTOS is pre-configured for static memary
% project wall indialize the MCU using the B5P, FreeRTOS will slho be intiakzed and 2 single thread to blnk the

RZ/\V2L case

& Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

8 Renesas RZNV C/C++ FSP Project
Renesas RZ/V C/C++ FSP Project
Project Template Salection
Project Template Selection

" Bare Metal (CM33) - Blinky

pins, stacks, and the € runtime envirenment.
[Renesas RZV.20.1 pack]

Of (:} Bare Metal (CM33) - Minimal

environment.
[Renesas RZV.2.0.1.pack]

Code Generation Settings
[] Use Renesas Code Formatter

Bare metal FSP project of Cortex-M33 core that includes BSP and will blink LEDs if available. This project will initialize clacks,

Bare metal FSP project of Cortex-M23 core that includes BSP. This project will initialize clocks, ping, stacks, and the C runtime

? < Back Next >

]

o]

OR

Cancel

@

o

o

&

Project Template Selection

Project Template Selection

" FreeRTOS (CM33) - Blinky - Dynamic Allocation

FreeRTOS FSP project of Cortex-M23 core that includes BSP and will blink LEDs if available. FreeRTOS is pre-configured for
dynamic memory allocation. This project will initialize the MCU using the BSP. FreeRTOS will also be initialized and a single
thread to blink the LEDs will be started,

[Renesas RZV.20.1 pack

" FreeRTOS (CM33) - Blinky - Static Allocation

FreeRTOS FSP project of Cortex-M33 core that includes BSP and will blink LEDs if available. reeRTOS is pre-configured for
static memory allocation. This project will initialize the MCU using the BSP. FreeRTOS will also be initialized and a single
thread to blink the LEDs will be started

[Renesas.RZV.20.1 packl

FreeRTOS (CM33) - Minimal - Static Allocation

Empty FreeRTOS FSP project of Cortex-M33 core with no threads, FreeRTOS is pre-configured for static memory allocation,
This project will initialize the MCU using the BSP.

[Renesas RZV.2.0.1 pack]

Code Generation Settings

] Use Renesas Code Formatter

| conce

RZ/V2H case

Figure 69 : RZ MPU Project Generator (Screen 4)
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When the project is created, e? studio displays a summary of the current project configuration in the RZ MPU
Project Editor.

45 [Blinky] FSP Configuration X =0

Summar g
y G P Cara

Project Summary
RENESAS

RZNV2H Evaluation Kit
ROADOGOSTHA4CEE
Core 6(CNM33_0)

si s an LED. No RTOS included. w202
Board Support Package Common Files w202
10 Port w202
w202
202
202
V5.8.0+renesas.0.fsp2.0.2
202
202
ipport package for RZ/V2H (RZAV2H) - FSP Data V202
valuation Kit RZAV2H Support Files (RZIV2H) 202

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks| Components I

Figure 70 : RZ MPU Project Editor and available editor tabs

On the bottom of the RZ MPU Project Editor view, you can find the tabs for configuring multiple aspects of
your project:

¢ With the Summary tab, you can see all the key characteristics of the project: board, device,
toolchain, and more.

o With the BSP tab, you can change board specific parameters from the initial project selection.

e With the Clocks tab, you can configure the MPU clock settings for your project.

e With the Interrupts tab, you can add new user events/interrupts.

e With the Event Links tab, you can configure events used by the Event Link Controller.

o With the Stacks tab, you can add and configure FSP modules. For each module selected in this
tab, the Properties window provides access to the configuration parameters, interrupt selections.

e The Components tab provides an overview of the selected modules. Although you can also add
drivers for specific FSP releases and application sample code here, this tab is normally only used
for reference.

The functions and use of each of the supported tabs is explained in detail in the next section.
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5.1.3 Duplication of Resources

In the case of RZ/V2H Core 4(CR8_0) or Core 5(CR8_1) project, duplicate resources are indicated as red
character in Stacks tab when using resources that are used in the linked Core 6(CM33_0) project.

The following image is an example of both Core 6(CM33_0) and Core 4(CR8_0) projects using same
resource. The duplication of r_gtm is indicated in Stacks tab. To avoid this duplication, please change the
channel resource in Properties of r_gtm.

{_CRB/configurationami - ¢ studio =]
Search Project RenesasViews Run Window Help

e - 5 Debug
= 01 |88 (Binky] FSP Configuration |81 “[Project CRB] F5P Confrguration =
Stacks Configuration Generate Project Content
Threads &) NewStack > £ Extend Stack > &) Remove
~ o HAL/Commen e
& g iaport 10 Por (rioport o5 g.timer2 Timer (.gtm}
# o e
Objects
Summary BSP Clocks Pins | Interrupts Event Links | @ Stacks Fomponents
T Properties X |1 Problems| @ Smart Browser| ) Console & =i

g_timer2 Timer (r_gtm)

Defauit (B57)

P
GTMO |

Perioaic

8

Hertz

PICLK for GTMO and 1. PSCLK for GTM2 to 7

Figure 71 : Duplication of resource between Core 6(CM33_0) and Core 4(CR8_0) projects

RO1AN6240EJ0202 Rev.2.02 Page 44 of 62
Oct.04.24 RENESAS




RZ/N2L, RZ/V2H Getting Started with Flexible Software Package
5.2 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user
code is executed is set by the configuration settings in the BSP tab. When you select a project template
during project creation, e? studio configures default values that are appropriate for the associated board. You
can change those default values as needed. The following sections detail the process of configuring each of
the project elements for each of the associated tabs.

5.2.1 Summary Tab

434 [Blinky] FSP Configuration X =0

Summary Generate Project Content

Project Summary

RENESAS

Board: RZIV2H Evaluation Kit

Device: ROADSGOSTHA4GEG

Core: Core 8(CM33_0)

Toolchain: GCC for Renesas RZ

Toolchain Version: 12.2.1.am-12.24

FsPversion: 202

ProjectType:  Flat

Location: Chwork2hiBlinky 5]

Selected software components
Simpls appiication that binks an LED. o RTOS inciuded. 202
Board Support Packags Common Files 202
10 ort 202
General Timer 202

12G Master Interface 202
erface Flash on Expanded Serial Peripheral Interface v2.0.2

) v5.8.0+renesas. 01p202
08G057HA4GEE 202

Board support package for RZV2H w202

Board support package for RZAV2H (RZIV2H) - FSP Data w202

Evaluation Kit RZ/V2H Support Files (RZIV2H) w202

Bo

I Summary| BSP| Clocks| Pins| Interrupts | Event Links| Stacks| Components I

Figure 72 : Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It
shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the
selected software components and modules used by the project. This is a more convenient summary view
when compared to the Components tab.

5.2.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the
lower left of the Project Configurations view as shown below.

Note: If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

- o e e e [E—
< > Summal locks | Pins | Interrupts | Event Links | Stacks Components
[T Properties X |2 Problems| @ Smart Browser| B Console

RZ/V2H Evaluation Kit

Settings  Properly Value
~ RIAQ9GO57H44GBG
part_number RIAQ9GO57H44GBG
rom _size_bytes 0
ram_size_bytes 131072
package_style LFBGA
package_pins 1368

~ RZ Common (CRE)
stack size (bytes)

Heap size (bytes) 0x8000
MCU Vee (mV) 3300
Parameter checking Disabled
Assert Failures Return FSP_ERR_ASSERTION
Error Log No Error Log
PFS Protect Enabled
C Runtime Initialization Enabled
Caches Enabled
w RZV2H (CR8_1)
series 2

Figure 73 : Configuration BSP tab
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The Properties view shows the configurable options available for the BSP. These can be changed as
required. The BSP is the FSP layer above the MPU hardware. e? studio checks the entry fields to flag invalid
entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written to
rzv_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.

5.2.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for
dedicated numerical calculation. For example, scif uart driver calculates the communication rate from the
settings in Clocks tab. Please note that the clock configuration is carried out on the main core (CA55) in
advance when CM33 work as sub core. Thus, clocks configuration here must align with the settings on
CA55.

In the case of CM33 cold boot, BSP will configure each clock setting in start-up process according to content
of Clocks tab.

5% [Biinky] FSP Configuration X =0

Clocks Configuration Generae Project Content

0SC 24MHz el 1ao0gHz  ysiDiv/2 -/ Div /2 a00MHiz ATCLK 400MHz

1 Div /4 400MHz {ovrz v I7CLK 200MHz
an 00MHz POCLK 100MHz

> Div /16 100MHz PICLK 100MHz

" Div /32 50MHz P2CLK 50MHz

v slovze

s3EMHz ~ 5/ sel: MUK XSPLCLKC v —{Div /2

5 PLLCLN 1.600GHz >/ Div /2 2000z

1 Div /4 400MHz P3CLK 400MHz

> Div /3 200MHz P4CLK 200MHz

5 Div /16 100MHz PSCLK 100MHz

> Div /20 80MHz NCLK 80MHz

' Div /32 50MHz PECL 50MHz

5 PLLDTY 1.600GHz Flov e v 16CLK 800MHz

1+/Div/2 ~ Fy>/Div /2 a00mz PTCLK 400MHz
Div /4 200MHz PACLK 200MHz
Div /8 100MHz PSCLK 100MHz

Summary | BP | Clocks| Pins | Interrupts| Event Links| Stacks| Components.

Figure 74 : Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written to:
rzv_gen/bsp_clock cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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5.2.4 Configuring Pins

The Pins tab provides flexible configuration of the MPU’s pins. As many pins can provide multiple functions,
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral
offers multiple options for the location of the receive and transmit pins for that module and channel. The
location and function of the pins are shown in the FSP Visualization view. For more information on the
function and color coding of the pins, please check the Legend in the FSP Visualization view.

= B |[%F Fs Visualization X | =5

| =] S O »

©¢ [Blinky] FSP Configuration X

Pin Configuration Generate Project Content

Select Pin Configuration L4y Export to CSV file [§- Configure Pin Driver Warnings sassas
| RZVZH-EVK.pincfg| ~ Manage configurations.
Generate data: |g_bsp_pin_cfg
PinSelection = '+ — |% Pin Configuration ~J Cycle Pin Group
iT.’.:Ef ter text Name Value Link
i d Ports ~
PO
P et T
P2 < >
D2 e
< > es

Pin Function | Pin Number

Summary | BSP | Clocks Interrupts | Event Links | Stacks  Components » legend

Figure 75 : Pin Configuration

The pin configurator includes built-in conflict checker. So, if the same pin is allocated to another peripheral or
I/0O function, the pin will be shown as red in the FSP Visualization view and with white cross in a red square
in the Pin Selection pane and Pin Configuration pane in the main Pins tab.

In the example shown below, port P70 is already used by the IRQ_IRQO, and the attempt to connect to this
pin to the GPT results in dangling connection error. To fix this error, select another port from the pin drop-
down list or disable the IRQ_IRQO.

43¢ *[Blinky] FSP Configuration X =g

Pin Configuration Generate Project Content

Select Pin Configuration [ Export to CSV file 5] Configure Pin Driver Warnings

[RzvaH-Evk pinctg v Manage configurations
Generate data: |g_bsp_pin_cfg

Pin Selection = & [ 1% Pin Configuration 2 Cycle Pin Group

© TmereeT = Pin Group Selection Mixed
~ N Timer: Operation Mode Custom
@ cpro
s ~ Input/Output
GTIOCOA @+p70 3

GPT2
GPT3
GPT4
GPTS
GPT6
GPT7
GPTS Module name:  GPTO
GPT9 9

GTIOCOAN None
GTIOC0B None
GTIOCOBN None

< >

Pin Function| Pin Number

Summary | BSP | Clocks| @ Pins| Interrupts| Event Links| Stacks | Components|

Figure 76 : e? studio Pin Configurator

When you click the Generate Project Content button, the pin configuration contents are written to:
rzv_gen/pin_data.c. This file will be created if it does not already exist.

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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In the case of versions earlier than RZ/V FSP v2.0.0, It does not support Pins tab and If user would like to
use I/O port, I/O Port setting should be applied to “src/pin_data.c” manually. For details on 1/O Port setting

and, please refer to Setting GPI

O with Flexible Software Package.

5.2.5 Configuring Interrupts from the Stacks Tab
You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority.
Select the driver in the Stacks pane to view and edit its properties.

¥ [Binky] FSP Conl

figuration 3

Stacks Configuration :
Generate Project Content
~ HAL/Common Stacks 4] New Stack > = % | Remove
& g ioport 0 Port Drives on riopart 9 g ioport 0 Port i gtime2 Tirver Oriver.
% g_timer2 Timer Driver on r_gtm Fiver.on Liopot oA e
Objects
Summary | BSP | Clocks | Pins | Intenmupts | Event Links | Stacks Components
[T Properties ¢ |[¥] Problems @ Smart Browser [ Console
g_timer2 Timer Driver on r_gtm
Sctiings  Propetty Value
 Commen
Defauk (B5P)

Parameter Checking

v Medule g_times2 Timer Driver om _gtm

Genensl
Interrupts
Extra Features

Figure 77 : Configuring Interrupts in the Stacks tab

File Edit Navigate Search Project RenesasViews Run Window F

Help

& | % ®m % Debug 7 Blinky Debug_flat =B R L 0% X e Q~- | v v L]
Q TUC/Co+ (3 FSP Configuration
& *(Blinky] FSP Configuration % Project Explorer x :
- o v 5 Blinky
Stacks Configuration Generate Project & Binaries
» Includes
Threads HAL/Common Stacks |2 New Stack v
~ &' HAL/Common e o Am ren
# g_ioport /0 Port Driver on r_ioport q;‘cs?" < Drive: : Connectivity x
Driver on r_joport FreeRTOS Timers 3 @& Port Output Enable for GPT on r_poeg
Middleware T & rzv o #_Timer Driver on r_gpt
— Search o sl O ]

Summary BSP| Clocks | Pins | Interrupts ks | Stacks| Components

Blinky Debug_Flatlaunch

2 configurationxm|
RIADTGOS54L23GBG.pinctg
r2v_cfgxt

Figure 78: Add new stack Timer (GTM)
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5.2.6 Creating Interrupts from the Interrupts Tab
On the Interrupts tab, the interrupt of the driver selected in the Stacks tab is registered.

" [Blinky] FSP Configuration 13 | =3

Interrupts Configuration ?

Generate Project Content

User Events 4| New User Event >

Event 1SR

Allocations

Interrupt Event 1SR
0 1D:46 GTMO INT (GTMa Interrupt) gtm_int isr

Summary [BSP | Clocks | Pins | Interrupts| Event Links| Stacks | Companents|

Figure 79 : Configuring interrupt in Interrupt Tab

And on the Interrupts tab, the user can add a peripheral interrupt create by user.
This can be done by adding a new event via the New User Event button.

5.2.7 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.

{8} *[MyProject] FSP Configuration X = a

Event Links Configuration Generate Project Content

User Events Produced &) New User Event > User Events Consumed €] New User Event

Eu Periphera) Function Event
I GPT_U0_GPT_GTCIL_N_0 (GPTO A and B both low interrupt) I é I Single port 0 GPT_UO_GPT_GTCIL_N_0 (GPTO A and B both low interr.. I

Summary |BSP | Clocks [ Pins | Interrupts | Event Links | Stacks| Components

Figure 80 : e? studio Project configurator — Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can be
defined by clicking the relevant New User Event button. Once a consumer is linked to a producer the link will
appear in the Allocations section at the bottom.

Note1: When selecting an ELC event to receive for a module (or when manually defining an event link), only
the events that are made available by the modules configured in the project will be shown.

Note2: On devices that do not have ELC, this tab is not available, and it is grayed out.
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5.2.8 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application
using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common
Stacks.

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.
3. Select a driver from the menu New Stack > Driver.

File Edit Navigate Search Project RenesasViews Run Window Help
& | % || ®|| % Debug 7 Blinky Debug_Flat O~ 29K ~E5 0% B Q- v A |

& *[Blinky] FSP Configuration x Project Explorer X
« &5 Blink

Stacks Configuration

[ C/C++ (& FSP Configuration

Threads HAL/Common Stacks
S — Am

# g_ioport /O Port Driver on _ioport ¥ g.joport /O Port Driver > Connectivity
= FreeRTOS > Timers

o
RIAOTGOS4L23GBG pinclg
Zv_cigtat

Summary BSP Clocks Interrupts | Eve: ks | Stacks Components

Figure 81 : e? studio Project configurator - Adding drivers

4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the
Properties view.

e? studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the rzv/fsp directory
e The main() function and configuration structures and header files for your application as shown in
the table below.

File Contents Overwritten by Generate
Project Content?
rzv_gen/main.c Contains main() calling generated | Yes

and user code. When called, the
BSP already has Initialized the

MPU.

rzv_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

rzv_gen/hal_data.h Header file for HAL driver only Yes
modules.

src/hal_entry.c User entry point for HAL Driver No

only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
rzv_cfg/fsp_cfg
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5.3 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded.
Modules common to all RZ/V MPU projects are preselected. All modules that are necessary for the modules
selected in the Stacks tab are included automatically. You can include or exclude additional modules by

ticking the box next to the required component.

[Blinky] FSP Configuration X

Components Configuration

Component
~ % BSP
v ¢ Board

custom

¥ rzv2l_smarc

v ¢ zv2l

Y dev
¥ dev
devi
devi
dev

7 tsp
v # CMSIS

ce
ce
ce
ce
ce

v ¢ (MSISS
¥ CoreM
Dsp

NN
v #% Common

v ?all

¥ fsp_common

v % HAL Drivers

v ?all

r_gpt
4 r.gtm

¥ r_ioport
Summary BSP Clocks

Version Description

Custom Board Support Files
Evaluation Kit RZ/V2L Support Files (RZ

Board support package for ROAD7G054.
Board support package for RZV2L

Board support package for ROAD7G054.
Board support package for ROAD7GO54
Board support package for ROAD7G054.
Board support package for RZ/V2L (RZ

Arm CMSIS Version 5 - Core (M
Arm DSP Library Source
Arm NN Library Source

Board Support Package Common Files

General PWM Timer
General Timer
1/0 Port

ks | Stacks Components

Variant

RIADTGOS

RIADTGOS.
RIAD7GOS.
RIADTGOS.

Figure 82 : Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected component into
the following folders:

rzv/fsp/inc/api
rzv/fsp/inc/instances
rzv/fsp/src/bsp

rzv/fsp/src/<Driver_Name>

e? studio also creates configuration files in the rzv_cfg/fsp_cfg folder with configuration options set in the
Stacks tab.
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5.4 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to the board

and execute it.

To debug an application, follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

BEr%-ic # -

T1 1F58 project Debug
Deug A3 :
Debug Configurations...

Organize Favarites..

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

B Deoug Configurations

Create, manage, and run configurations

Pame: | WiProject Deaug

x

[F) Main . %5 Debugger e Startup [] Commen | % Source
ol
€

Cov Applicasion —
Cos Aemete Appiicari
EASE Script [MyProject Hrowse.
II% 0B Hardware Debuggim | /-« Appiication:
] GDE OpenOCD Debuggin
Deng My ectelt
[ GDB Simulator Debugging [ 1g/MyP raject.
Variables.. | SesrchProject..|  Browse..

Build (i requires) before launching

on: |Use Adtive

Applization

8 Hardoore D
] MyProject Debug

[ Aenesas Simulator Debug

« >
Filter matched 14 of 16 items

@

3. Secure and Non-secure Vector Address are configured in the Connection Settings tab of the Debugger
tab. The settings in below image are for setting the address of Secure and Non-secure Vector Offset (*)
mapped in Blinky project. Please note that these addresses vary in accordance with linker settings.

(*: In the case of RZ/V2H project, Non-secure Vector is empty since it is not used.)

8 Slect Symbol

Address. ~
Ox72eff549
0x6001084d
Ox72ef535

. Q10010 |

sp_clock init veneer

I freq_var_init

Ox72effsbe

0x600107b1
0x60010835
0x60010849

<

Cancel

Address A
0x6001084d
Ox72eff535
Ox72eff581

8 Debug Configurations o x
B Filter: |
Create, manage, and run configurations
Symbol
© Systeminit S
: ® UsageFault Handler NS
Ef =X B Name: [Blinky Debug_Flat | © UsageFault_ Handler_S
4 ext B Mnin_ & Startup | [ Common | &/ Source
[€] C/C++ Application
€] /C++ Remote Application ||| Debug hardware: J-Link ARM | Target Device: | RAOTGOL23GBG.I | .
L EASE Script
[€] GDB Hardware Debugging GDB Settings  Connection Settings  Debug Tool Settings © bsp
[E] DB OpenOCD Debugging « JTAG Scan Chain 5 @ bsp clock init
£ GOB Simulator Debugging (1 Multiple Devices. No v ® bsp_init
] Java Applet iRPre
[7] Java Application DRPre
73, Launch Group « Connection
&, Remote Java Application Register initialization No v
v |3 Renesas GUB Herdware Deb Reset on connection No v
[E9 Biinky Debug_Flat Reset before run No ~
[E7] Renesas Simulator Debuggir 1D Code (Bytes) FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF . 8 Select Symbol
Hold reset during cennect No v .
Reset before download No v Fiten
Prevent Releasing the Reset of the CM3 Core_Yes v ther
[secuce vecior Address il | Symbol
[on-secure Vector Address
o ) © UsageFault_Handler_NS
Core clock (MH2) ® UsageFault_ HandlerS
v TstZone © Warm Reset S
Set TrusiZone secure/non-secure boundaries No . -
< >
Filter matched 13 of 15 items = ® bsp_clock |
© bsp init
2 [ Debug | Close © bsp_irg_cfg

0x00010000 |

xB00107b1
0xB0010835
60010849
xE00T0B48

Cancel

4. Connect the board to your PC via a standalone Segger J-Link debugger and click Debug.
Note: For details on using J-Link and connecting the board to the PC, see 3.1.2.2.JTAG connection.
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5.5 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for example,
to change optimization level of the compiler or add a library to the linker). Such modifications can be made
from within e? studio through the menu Project > Properties > Settings when the project is selected. The
following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly
different depending upon the toolchain being used.

B8 Properties for Blinky [m} x
| Settings T T
Resource
Builders
w (/== Build Configurstion: | Debug [ Active] | | Manage Configurations...
Build Varizbles
Environment
Logging  ToolSetings BB Toolchain  #° Build Steps Build Atifact [n} Binary Parsers € EmorParsers
Settings
Tool Chain Editor |22 Target Processor ARM family cotem-md e
C/C++ General (2 Optimization p— =
MCU ([ Wamings rehitecture Toolchain default w
Praject References ([ Debugging Instructionset | Thumb (-mthumis)
;3 o Froes &
Reﬂs.sas QE ) w B C::JU ARM Cross Assembler I Thurnb interwork (-mthumb- interwork]
Fun/[Iebug Settings 15 Preprocessor
Task Repositery % Includes Endianness Toalchain default w
Task Tags iF e Float AEI FF instructions (hard)
Walidation Wiis cell aneces
w 1) GMU ARM Cross C Compiler FRU Type Fpud-sp-d 16 w
(% Preprocessar ; E
r Unaligned access | Toolchain default -
2 Indudes
Optimization Generic [-megu= genens
Warmings
|2 Miscelaneous Foclichacietauil
w B GHU ARM Cross C Linker TR e P
(B Genenal
B Libraries Toalchain default
 Miscellaneous Enabicd (rsind
w B GHU ARR Cross Create Flash image
Geners| Small [-memadel=small)
WA TR ADEE e ik Cioe i
< >
:_?" Apply and Close Cancel

Figure 83 : e? studio Project toolchain settings

The scope for the settings is project scope which means that the settings are valid only for the project being
modified.

The settings for the linker which control the location of the various memory sections are contained in a script
file specific for the device being used. This script file is included in the project when it is created and is found
in the script folder (for example, /script/fsp.ld).
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5.6 Importing an Existing Project into e? studio
1. Start by opening e? studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist,
proceed with the following steps:

a. Atthe end of e? studio startup, you will see the Workspace Launcher Dialog box as shown in the
following figure.

Eclipse Launcher

Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | (&

\Users\<user_name\e2studio\workspace

Browse...

[1Use this as the default and do not ask again
¥ Recent Workspaces

Figure 84 : Workspace Launcher dialog

b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure.
e? studio creates a new workspace with this name.

Eclipse Launcher

Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

QLTSRS O\ Users < username\e2studio\new workspace]

Browse...

[ Use this as the default and do not ask again

+ Recent Workspaces

Figure 85 : Workspace Launcher dialog - Select Workspace
c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench
arrow button to proceed past the Welcome Screen as seen in the following figure.

RENESAS

Welcome to e2 studio

O]

WWorkbench

Figure 86 : Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu in the menu
bar, as shown in the following figure.

Q fspWorkspace - FSPproject/confi

File Edit Navigate Search Proje €= Menu bar

4 Debug <« Tool bar

|=)

o}

Figure 87 : Menu and tool bar
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4 Click Import on the File menu or “Import project” on Project Explorer, as shown in the following figure.

File Edit Navigate Search Project RenesasViews Ru
New AsShiftsN > | [¢5 Project Explorer 52 =7
Open File... TSR

Open Projects from File System..

There are no projects in your workspace.
To add a project:

Recent Files >

ar

Convert Line Delimiters To >

Prin Ctri+P
7y Expert..

Properties AltsEnter

Switch Workspace >
Restart

Exit

Figure 88 : File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing
Projects into Workspace, to import the project into the current workspace.

& import [m] x
Select \“
Create new projects from an archive file or directory. E E

Select an import wizard:

[type filter text |

v [= General -
B Archive File
[ CMSIS Pack
=3 Existing Projects into Workspace
(=} File System
¥ GNUARM-NONE/RZ(DS-5) project conversion to GCC ARM Embedded
[T Preferences
[} Projects from Folder or Archive
=} Rename & Import Existing C/C++ Project into Workspace
) Reneas Webt ~ EQOH# T |- FOUTH
Ta# Renesas CATEKOR (CS+) FOUIIR
T Renesas CC-RX/CC-RL (CS+) FOTI
&# Renesas GitHub FreeRTOS (with IoT libraries) 70T+

= UC++

(2= Install

®@ < Back Finish Cancel

Figure 89 : Project Import dialog with "Existing Projects into Workspace™ option selected

6. Click Next.
7. To import the project, use either Select archive file or Select root directory.
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a. Click Select root directory file as shown in the following figure.

& import

Import Projects

(®) Select root directary: |\

Select a directory to search for existing Eclipse projects.

O Select archive file:

Projects:

Options

[ Search for nested projects

[ Copy projects into workspace

[ Close newly imported projects upon completion
[[JHide projects that already exist in the workspace
Working sets

[ Add project to working sets

< Back

Select All

Deselect All

Refresh

New...

Cancel

Figure 90 : Import Existing Project dialog 1 - Select root directory

8. Click Browse.

9. For Select root directory, browse to the project folder that you want to import.

10.Select the file for import.
11.Click Open.

12.Select the project to import from the list of Projects, as shown in the following figure.

Import
Import Projects

Select a directory to search for existing Eclipse projects.

(@ Select root directory: | C:\works_RZV\work\Blinky
O Select archive file:
Projects:

Blinky (C:\works_RZV\work\Blinky)

e ] Browse...

Select All
Deselect All

Refresh

Figure 91 : Import Existing Project dialog 2

13.Click Finish to import the project.
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6. Multi-Core Debug
In the case of RZ/V2H, FSP supports multi-core (CM33 core, CR8 core0 and CR8 core1) operation.

This section describes how to debug multi-core environment by running Blinky project for each core.

6.1 Project Creation for each Core
1. Create workspace for each core.

workspace_cm33
workspace_cr8_0

workspace_cr8_1

Figure 92 : Workspace creation

2. Launch e? studio and specify workspace for CM33 core.

& & studio Launcher O X

Select a directory as workspace

e’ studio uses the workspace directory to store its preferences and development
artifacts.

: ‘ ‘\workspace_cm33 ~| | Browse...

[[] Use this as the default and do not ask again

» Recent Workspaces

Figure 93 : Launching e? studio for CM33 Core Workspace

3. Generate new project for CM33 core in accordance with section 4.3.
In the case of CM33 core project, ensure to select Core and Project Template Selection as below.

8 Renesas RZ/V C/C++ FSP Project o X B Renesas RZ/V C/C++ FSP Project [} ®
Renesas RZ/V C/C++ FSP Project p— Renesas RZ/V C/C++ FSP Project —

Device and Tools Selection Project Template Selection

Device Selection Project Template Selection

1 if (O} .
FSP Version: 202 .| Board Description ® d Bare Metal (CM33) - Blinky
Board: RZ/V2H Evaluation Kit v Bare metal FSP project of Cortex-M33 core that includes BSP and will blink LEDs if available. This project will initialize clocks,
pins, stacks, and the C runtime emvironment,
Device: RIAD9GOSTHA4GEG [Renesas RZV.2.0.2 pack]
|Eme- Core 6(CM33.0) v| Device Details .
/| _se Bare Metal (CM33) - Minimal
Language:  ©C O C++ Tiustzane N G} Bare metal FSP project of Cortex-M33 core that includes BSP. T twill initialize cl tacks, and the € runt
e 138 | Bare mel project of Cortex-M33 core that includes BSP. This project will initialize clocks, pins, stacks, and the € runtime
environment
Processor Cortex-M33 Renesas RZV202 pack]

Toolchains Debugger

GNU ARM Embedded J-Link ARM v

— Code Generation Settings

1221am-12-24 v Manage Toolchains Use Renesas Code Formatter

©) <o i Canel @ <ma |G Carce

Figure 94 : Setting of CM33 core project

4. Build the Blinky project for CM33 core.
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5. Generate new project for CR8 core0 in accordance with section 4.3.

In the case of CR8 core0 project, ensure to select Core, Preceding Project, and Project Template
Selection as below.

) Renesas RZ/V C/C++ FSP Project o x {8 Renesas RZ/Y C/C++ FSP Praject o X
Renesas RZ/V C/C++ FSP Project — Renesas RZ/V C/C++ FSP Project —
Device and Tools Selection Preceding Project or Smart Bundle Selection
Device Selection
Board Desaription @ Preceding Project:  Blinky_cm33 -
FSP Version: 202 v 5 - .
Choose this opticn if you have access to the project source code of the preceding processor core or security context,
Board RZ/UZH Evaluation kit -l - O Smart Bundle:
Device: RIAD9GOSTHA4GEG 3
Cre Core 4(CRBD) ... "I Workspace i
Device Details
@®c Ocs
Language:  ®C OC++ TuetZone P
Ping 1268 S
receding Project/Smart Bundle Details
Processor Cortex-R8 9 Proj
FSP version 202
Toolchain GNU ARM Embedded
Toolchain version 1221.8m-12-24
Board RZ/V2H Evaluation Kit
Toolchains Debugger Device RIATSGOSTHAAGREG
GNU ARM Embedded J-Link ARM v Core CM33.0
Zones CM33.05,CM33 0.5
1221.arm-12-24 ~ Manage Toolchain:
< >
@ @
@ < Back Next > Finish Cancel ®@ <Back Finish Cancel
8 Renesas RZ/V C/C++ FSP Project o X

| Renesas RZ/V C/C++ FSP Project
Project Template Selection

Project Template Selection

| @ O Bare Metal (CR8 core0) - Blinky
W% Bare metal FSP project of Cortex-R8 cored that includes B5P and will blink LEDs if available. This project will initialize clacks,
pins, stacks, and the C runtime environment,
RenesasR7V.2.0.2.pack]

| O () " Bare Metal (CR8 core0) - Minimal

Bare metal FSP of Cortex-R8 core project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime
environment,

[RenesasRZV.2.0.2 pack]

| Code Generation Settings
| lUse Renesas Code Formatter

@
&

<Back Next > Cancel

Figure 95 : Setting of CR8 core0 project

6. Build the Blinky project for CR8 coreO.
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7. Generate new project for CR8 core1 in accordance with section 4.3.

In the case of CR8 core1 project, ensure to select Core, Preceding Project, and Project Template

Selection as below.

) Renesas RZ/V C/C+ + FSP Project

o X ) Renesas RZ/V C/C++ FSP Project o X
Renesas RZ/V C/C++ FSP Project — Renesas RZ/V C/C++ FSP Project —
Device and Toals Selection Preceding Project or Smart Bundle Selection
Device Selection
® -
Board Description ® Preceding Project.  Blinky.cré_0
FSP Version: | 202
Choose this option if you have access to the project source code of the preceding processor core or security context.
Board: RZ/V2H Evaluation Kit “] D oman Bundle
Device: RIADIGOSTHAIGBG
————— -]
Device Details
Lenguage: @®C OC++ TrustZone No
Pins 1368 . i
Processor Cortex-R8 Preceding Project/Smart Bundle Details
FSPversion 202
Toolchain GNU ARM Embedded
Toolchain version 12.21.am-12-24
Board RZ/V2H Evaluation Kit
lackinis) Bebuooey Device ROADIGOSTHAAGRG
GNU ARM Embedded J-Link ARM v Core CRE_D
Zones €M33_0.5,CM330.5, CR8_0S
122.1.arm-12-24 ~ Manage Toolchains...
(?/ f}acg'"i“' Finish Cancel ‘:_’) < Back Finish Cancel

8 Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

Project Template Selection

Project Template Selection

® d Bare Metal (CR8 core1) - Blinky
clocks, pins, stacks, and the C runtime environment
[Renesas.RZV.2.0.2.pack]

W Bare metal FSP project of Cortex-RE carel that includes BSP and will blink LEDs if available. This project wil initialize

O ()‘ Bare Metal (CR8 corel) - Minimal

runtime environment,
[RenesasRZV.2.0.2.pack]

Code Generation Settings
[:7] Use Renesas Code Formatter

< Back

W Bare metal FSP project of Cortex-R core1 that includes BSP. This project will initialize clocks, pins, stacks, and the C

Cancel

Figure 96 : Setting of CR8 core1 proje

o

Build the Blinky project for CR8 core1.
3 projects are created in CM33 core workspace.
Copy all projects to CR8 core0 workspace and CR8 core1 workspace.

ct

.metadata

i i i

i~ workspace_cm33 i

"3 - A copy
workspace_cré_(
workspace_cr8_1 « N

Blinky_cm33
Blinky_cr8_0
Blinky_cr8_1

Figure 97 : Copy the project
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6.2 Debugging the Project for each Core

1. Select the Debug Configuration on e? studio of CM33 core workspace and click Debug.

@ Debug Configurations

o x
Create, manage, and run configurations g\'
e . X 57~ Name: [Blinkycm33 Debug_Flat
BRI Window _Help type filter text [} Main| %5 Debugger | B Startup| % Source| =] Common
Renesas Device Partition Manager —
T] C/C++ Application Project:
TraceX > [€] c/C++ Remote Application -
@ Tracealyzer > EASE Script |Blmky,cm}3 Browse...
Q Run CrrisF11 [€] GDB Hardware Debugging C/C++ Application
%, Debug AL | €7 GDB Simulator Debugging (RF |Debum9n‘nky cm33eli
Run History i | @ Launch Group =
O Runas > v ©°| Repesas GOB Harduare Debuc Variables.. || Search Project. Browse
Fun Conoustion: Build (if required) before launching
Debug Histery > 1 Blinky_cr8_0 Debug_Flat
4 Debug As . 7 Blinky_cr 1 Debug_Flat Build Configuration:  Use Active ~
3 Renesas Simulator Debugging ||| (5 enpie auto build O Disable auto build
Q_External Tools e @ Use workspace settings Configure Workspace Setfings
< >
Revert Iy
Filter matched 11 of 13 items
Figure 98 : CM33 Core Debug Configuration
2. Launch new e2stuio for CR8 core0 workspace.
& < studio Launcher [m| * ‘
Select a directory as workspace
e? studio uses the workspace directory to store its preferences and development
artifacts.
\workspace_cr8 0
[[] Use this as the default and do not ask again
} Recent Workspaces
Launch Cancel
. . . 2 .
Figure 99 : Launching e? studio for CR8 Core0 Workspace
. . > . .
3. Select the Debug Configuration on e? studio of CR8 core0 workspace and click Debug.
@ Debug Configurations [m] o

Create, manage, and run configurations

Name: |Blinky_cr8_0 Debug Flat

@

Run Window Help [-) Main| 3 Debugger| # Startup| ] Common | % Source
Renesas Device Partition Manager ” [€] ¢/C++ Application Project:
[€] ¢/C++ Remote Application -
@ Tracex EASE Seript Blinky_crB_0 Browse...
B Tracealyzer > =
©] GDS Hardware Debugging C/C++ Application:
Q. Run Ctri+F11 5 " P .
3 " GDB Simulator Debugging (RH | 1o ai " oo
# Launch Group
Run History > v [ Renesas GDB Hardware Debug: Variables_. | |Search Project Browse.
Run A > - o
) Bt -~ S Build (if required) before launching
Run Configurations... Blinky cr8 0 Debug_Flat
Debug History 5 €1 Biinky,cr8. 1 Diebug, Flat Build Configuration;: Use Active: -
. Detg A5 ’ €1 Renesas Simulator DEbLOINg (| b auto build O Disable auto build
Debug Configurations -
® Use workspace settings igure Workspace Settings.
Q. External Toals ’
< >
Reyert Apply

Filter matched 11 of 13 items

|
?

Figure 100 : CR8 Core0 Debug Configuration
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4. Launch new e2stuio for CR8 core1 workspace.

& < studio Launcher O * ‘

Select a directory as workspace

e” studio uses the workspace directory to store its preferences and development
artifacts.

\worlapace_crﬂjl Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

Figure 101 : Launching e? studio for CR8 Core1 Workspace

5. Select the Debug Configuration on e? studio of CR8 core1 workspace and click Debug.

@ Debug Configurations

Create, manage, and run configurations

LR xXey- Name: | Blinky_cré 1 Debug Flat |

Run | Window Help type filter text |-} Main| %% Debugger | B Startup [] Common | &

5 Source
Renesas Device Partition Manager | (21 ¢/ + Application

— Project:
TraceX > T C/C++ Remote Application
@ Tracealyzer > EASE Script [Brinky_cra_1 e
@, Run Cul+F11 [€] GDB Hardware Debugging CfC++ Application:
2 E
Debug m | % GDB Simulator Debugging (RH || [n.epug/miinky_crd 1.t
Run History > 8 Launch Group
© RunAs 3 ~ [E7] Renesas GDB Hardware Debug Variables.. | | Search Project. Browse..
Run Configurations... [E7 Blinky_cm33 Debug_Flat Build (if required) before launching
Debug History > 6] Blinky cr8 0 Debug Flat
al Build Configuration: Use Active -
#_Debug As > | Blinky_cré_1 Debug_Fla
Debug Configurations. €7 Renesas Simulator Debugging |||~ grahie auto build ) Disable auto build
Q. Exernal Tools >

@ Use workspace settings Configure Workspace Settings.

< >

Revert Apply
Filter matched 11 of 13 items .

@

Figure 102 : CR8 Core1 Debug Configuration

6. You can debug each core project.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi. (Max.) and Vix (Min.).
7. Pronhibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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